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1. About this Manual 
 

This Windows Driver Installation Manual provides information on installation, detailed 
specifications, and usage of the printer’s Windows Driver according to PC operating 
system (OS). 
 
We at BIXOLON maintain ongoing efforts to enhance and upgrade the functions and 
quality of all our products. In following, product specifications and/or user manual content 
may be changed without prior notice. 
 

 
 

2. OS Environment 
 
The following operating systems are supported by this Windows driver. 
 

Microsoft Windows XP (32bit/64bit) 
Microsoft Windows Server 2003 (32bit/64bit) 
Microsoft Windows Vista (32bit/64bit) 
Microsoft Windows Server 2008 (32bit/64bit) 
Microsoft Windows Server 2008R2 (64bit) 
Microsoft Windows 7 (32bit/64bit) 
Microsoft Windows 8 (32bit/64bit) 
Microsoft Windows Server 2012 (64bit) 

 
 
 

3. Windows Driver Preparation 
 
The Windows Driver is included in the enclosed CD, and Latest file versions can be 
downloaded from the Bixolon website. (www.bixolon.com) 

http://www.bixolon.com/
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4. Windows Driver Installation 
 

4-1 Installing on Windows XP / Server 2003 
 
 

4-1-1 Via Serial Port or Bluetooth 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select a COM port to be used and then click Next. 
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4) If you are using a Bluetooth Serial port, click Bluetooth Stack for Windows and then 
select a Bluetooth driver vendor. 

※ Skip this step if the printer is connected with a serial cable. 

 
5) Click Next to install Windows driver. 
 
6) Click Yes to reboot the PC. 
 

 
 
7) Open the printer properties window in the Windows OS. 

※ Control Panel – Printers and Faxes. 

 
8) In the Ports tab, click Configure Port. 

※ Skip this step if you are using a Bluetooth Serial port. 

 
9) Match the communication settings to those of the printer. The communication settings of 

the printer can be performed by conducting a self-test. 

※ Skip this step if you are using a Bluetooth Serial port. 
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10) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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4-1-2 Via Parallel Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select a LPT port to be used, and then click Next. 
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4) Click Yes to reboot the PC. 
 

 
 
5) Open the printer properties window in the Windows OS. 

※ Control Panel – Printers and Faxes. 

 
6) Click Print Test Page and check printing status. Proper installation of the driver is 

indicated if the test page is printed normally. 
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4-1-3 Via USB Port 
 
1) Double-click the Windows Driver installation file. 
 

2) Click Next. 
 

 
 
3) Select USB and then click Next. 
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4) Click OK. 
 

 
 
5) Turn off the printer and then turn it on. The printer driver will be installed automatically. 
 
6) Open the printer properties window in the Windows OS. 

※ Control Panel – Printers and Faxes. 

 
7) Click Print Test Page and check printing status. Proper installation of the driver is 

indicated if the test page is printed normally. 
 

 
 



SRP-350plusIII 

Rev. 1.02 - 11 - 

4-1-4 Via Ethernet / Wireless LAN Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select Ethernet / Wireless LAN.  
 
4) Enter the IP address and port number, and then click Next. 
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5) Click Yes to reboot the PC. 
 

 
 
6) Open the printer properties window in the Windows OS.  

※ Control Panel – Printers and Faxes. 

 
7) In the Ports tab, click Configure Port…. 
 
8) Match the communication settings to those of the printer. 
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9) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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4-2 Installing on Windows VISTA / Server 2008 / 7 / 8 / Server 2012 
 

4-2-1 Via Serial or Bluetooth 
 

1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select a COM port to be used and then click Next. 
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4) If you are using a Bluetooth Serial port, click Bluetooth Stack for Windows and then 
select a Bluetooth driver vendor. 

※ Skip this step if the printer is connected with a serial cable. 

 
5) Click Next to install Windows driver. 
 
6) Click Yes to reboot the PC. 
 

 
 

7) Open the printer properties window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 

 
8) In the Ports tab, click Configure Port. 

※ Skip this step if you are using a Bluetooth Serial port. 

 
9) Match the communication settings to those of the printer. The communication settings of 

the printer can be performed by conducting a self-test. 

※ Pass this step if you are using a Bluetooth Serial port. 
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10) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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4-2-2 Via Parallel Port 
 

1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select a LPT port number to be used and click Next. 
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4) Click Yes to reboot the PC. 
 

 
 

5) Open the printer properties window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 
 

6) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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4-2-3 Via USB Port 
 
1) Double-click the Windows Driver installation file. 
 

2) Click Next. 
 

 
 
3) Select USB and then click Next. 
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4) Click OK. 
 

 
 
5) Turn off the printer and then turn it on again. The printer driver will be installed 

automatically. 
 
6) Open the printer properties window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 

 
7) Click Print Test Page and check printing status. Proper installation of the driver is 

indicated if the test page is printed normally. 
 

 
 
 



SRP-350plusIII 

Rev. 1.02 - 21 - 

4-2-4 Via Ethernet / Wireless LAN Port 
 

1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select Ethernet / Wireless LAN.  
 
4) Enter the IP address and port number, and then click Next. 
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5) Click Yes to reboot the PC. 
 

 
 
6) Open the printer properties window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 

 
7) In the Ports tab, click Configure Port…. 
 
8) Match the communication settings to those of the printer. 
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9) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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5. Detailed settings of Windows driver 
 

The following detailed functions can be configured after installing the Windows driver. 
 

5-1 Layout 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 

2) In the General tab, click Preferences.  
 

3) Click the Layout tab. 
 
 

5-1-1 Number of Prints 
 

The Number of Prints is set to 1 by default. Set this value bigger than 1 to set the number 
of copies to print. The value should be within the range of 1 to 100. 
 
 

5-1-2 Paper Type 
 

You can choose Receipt or Ticket as paper types. Receipt allows flexible paper length 
according to the data length. Ticket print in fixed length even the print data is short. Default 
setting is “Receipt”. 
 

Receipt : Receipt allows flexible paper length according to the data length. 
Ticket : Ticket print in fixed length even the print data is short. 
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5-1-3 Paper Size 
 
Paper size of 72 x 297 mm is selected by default, and the following sizes can be selected.  
 

72  40 mm 72  160 mm 72  3276 mm 

72  80 mm 72  200 mm  

72  120 mm 72  297 mm  

   
If a custom paper size is required, click the “…” button to add or update a custom paper 
size and then, click the “Save” button after specifying the paper width/length and a paper 
name. If the specified paper name already exists on the system, you can update the paper 
width/length. 
 
Valid Paper Width  : 25.4 mm ~ 72 mm 
Valid Paper Length : 25.4 mm ~ 3276 mm 

 

 
 

You can choose the new paper size on the “Paper Size” combo-box after adding a paper 
size. 
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5-1-4 Image Rotation 
 
The image can be rotated 90˚, 180˚, and 270˚ in a clockwise direction for printing. When 
the rotation function is used for printing, device font is converted to True Type Font. 
 
 
5-1-5 Paper Reduction 
 
This function reduces the print image size down to 25% to save print paper. When the 
reduction function is used, device font is converted to True Type font for printing. 
 
If the barcode font also needs to be reduced, select the Enable reducing barcode button. 
Select Disable reducing barcode button if it is not required. 
 
 

5-1-6 Crop Function 
 

This function crops the upper and lower end of the printing area by the specified number of 
pixels. It helps reduce the margin at the top and bottom when there is excessive margin. 
The value should be within the range of 1 to 255 [pixel]. 
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5-2 Dithering 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences. 
  
3) Click the Dithering tab. 
 

This printer model is a black and white printing device including dithering function, graphic 
processing, grayscale print function, and brightness level adjust function to produce a 
sharper or softer image. The following dithering algorithm option is available when 
Monochrome option is selected. 
 
- None  
- Error Diffusion  
- Ordered Dither  
- 4x4 Matrix  
- 8x8 Matrix  

 
Dithering algorithm is not available if Greyscale is selected, and print speed may become 
slower because the amount of data to send to the printer becomes larger. 
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5-3 NV Image/Commands 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences. 
  
3) Click the NV Image / Command. 
 
NV image downloaded and stored in the printer can be inserted at the beginning and/or 
end of the document and beginning and end of each page, or printer command can be 
inserted before sending printer data to the printer. NV image can be downloaded using the 
Unified POS Utility. 
 

- Start Doc : Insert commands or NV image at the top of the document. 
- Start Page : Insert commands or NV image at the top of the page. 
- End Page : Insert commands or NV image at the end of the page. 
- End Doc : Insert commands or NV image at the end of the document. 

 



SRP-350plusIII 

Rev. 1.02 - 29 - 

5-4 Barcodes 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences.  
 
3) Click the Barcode. 
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5-4-1 1d Barcodes 
 
Windows driver supports one-dimensional barcode type as shown in the following table. 
Set the one-dimensional barcode type supported by the Windows driver in the “Barcode 
Font Name” field to print the bar code.  
 

Barcode Font Name Barcode Type Size (Point) Supported Characters 

Barcode1 UPC-A 20/40/60/80 Numeric: 0~9 

Barcode2 UPC-E 20/40/60/80 Numeric: 0~9 

Barcode3 JAN13(EAN) 20/40/60/80 Numeric: 0~9 

Barcode4 JAN8(EAN) 20/40/60/80 Numeric: 0~9 

 
Barcode5 Code39 20/40/60/80 

Numeric: 0~9 
Symbols: $, +, -, ., / 

Letters: A~Z 

Barcode6 ITF 20/40/60/80 Numeric: 0~9 

 
Barcode7 Codabar 20/40/60/80 

Numeric : 0~9 
Symbols: $, +, -, ., /, : 

Letters: A~D 

Barcode8 Code93 20/40/60/80 ASCII CODE: 0~127 

Barcode9 Code128 20/40/60/80 ASCII CODE: 0~127 

 
Detailed settings for one-dimensional barcode 
 
Select “Barcode Font Name” and “Barcode Type” of one-dimensional barcode and click 
the “Properties” button.   
 

 
  

This width, height, and HRI (Human Readable Interpretation), print position, and HRI Font 
of the bar code can be programmed from this window. 
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5-4-2 2d Barcodes 
 
Windows driver supports two-dimensional barcode type as shown in the following table. 
Set the two-dimensional barcode type supported by the Windows driver in the “Barcode 
Font Name” field to print the barcode. 
 

Barcode Font Name Barcode Type Size (Point) 

2D-Code1 PDF417 9.5 

2D-Code2 QR Code 9.5 

 
Detailed settings for two-dimensional barcode 
 
Select “Barcode Font Name” and “Barcode Type” of one-dimensional barcode and click 
the “Properties” button. Various options such as width, height, size, and error 
compensation level can be configured depending on the type of two-dimensional barcode 
from this window as shown in the following picture. 
 

 

 
 

<QR Code> 

 
<PDF417> 
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5-5 Cut / Cash Drawer 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences 
.  
3) Click the Cut / Cash Drawer. 
 

Various functions including Open Cash Drawer, Internal Beep, Line Feeds and Paper-Cut 
can be inserted at the beginning or end of the document from this tab.  
 
Cut: Paper can be cut at the end of each page or each document. 

Page/Job : No Cut / No Cut : Paper is not cut after printing. 
Page/Job : No Cut / Partial Cut : Paper is cut at the end of each document (Job). 
Page/Job : Partial Cut / Partial Cut : Paper is cut at the end of each page. 

 

Line feed: It is possible to set the number of line feeds between 0 and 99 for adding blank 
lines at the end of printing. 

 

Cash Drawer:  
- To open a cash-drawer at the start time of the printing procedure, tick Open before 

printing #1 or Open before printing #2 under Begin Job label.  
- To open a cash-drawer at the start time of the printing procedure, tick Open before 

printing #1 or Open before printing #2 under End Job label. 
 
Internal Beep:  

- To make a beep sound at the start time of the printing procedure, tick Internal Beep 
under Begin Job label.  

- To make a beep sound at the end time of the printing procedure, tick Internal Beep 
under End Job label. 
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5-6 Utility 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences.  
 
3) Click the Utility. 
 
 

5-6-1 Unified POS Utility 
 
Refer to the Unified POS Utility manual contained in the CD for details. 
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5-6-2 Special Font Edit Utility 
 

The purpose of the “FontControlA” font is not for text printing. It is used to define the 
printer command, assign the defined printer command to a specific ASCII character, and 
send it to the printer. The range of ASCII code that the command can be assigned is from 
0x20 to 0x7F, and the command can be easily assigned using this utility. 
 
1) Click Special Font Edit Utility. 
 
2) Select an ASCII code character and enter the printer command. All values should be 

entered in hexadecimal number format. 
 
3) Click Apply, and then click OK.  
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5-6-3 Journal Viewer 
 

Journal is a function to save a copy of printed receipts. Copies can be saved without using 
journal printer with this function. Journal saves each printed document in a file and the 
saved file can be viewed by print and search data using this utility. 
  
1) Tick Enable Journal and then click Journal Viewer. 
 
2) The following window appears. 

 

 
 
3) Click Search, and set start date and end date for searching all files created within a 

specific date range. 
 

 
 

4) Select a file name from the list, and click Print to print the data stored in the file. 
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5-6-4 Text-Key Function 
 

Text-Key Function is a utility to replace specific text (Text-Key) with other texts or graphic 
images, and to add images to the bottom of receipts. This function can be used only when 
using device fonts. It has no effect when using TTF fonts (True Type Fonts) or the data for 
Text-Key does not exist on a Print-Job.  
 

▶ How to replace Text-Key with other texts. 

 
1) Tick Enable Text-Key Function and then click Text-Key Function. 
 

 
 
2) Click Add New Key, type a text to be used as Text-Key, and then click OK.   
 

 
 

 
 

3) If the Text-Key is selected, The Configuration button is enabled.  
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4) Click Configuration to enter a text, which is used to replace the selected Text-Key with 
the text entered. For example, if you enter “APPLE” in the text box as below, the Text-
key, “POTATO” can be replaced with “APPLE”. 

 

 
 

▶ How to replace Text-Key with a graphic image and to add it to the bottom of receipts. 

 
1) This utility can also replace the selected Text-Key with a graphic image instead of texts 

and can add a graphic image to the bottom of receipts. It is necessary to add images to 
the image list. 

 
2) Click Add New Image to browse for an image to add to the list. 
 

 
 

3) Enter a unique name to be added, adjust the brightness, select a dithering type, and 
then click OK. Repeat 2 to 3 step to add up to as much as you want.  
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4) Select a Text-Key in the Text-Key list, and then click Configuration.  
 

   
 

5) To replace the selected Text-Key with a graphic image, select one of the available 
identifier via the combo box under “Replacement” label. There are two replacement 
functions but only one of the two is available.  

 
6) In order to print a graphic image to the bottom of receipts, select one of the available 

identifier via the combo box under “Adding a image to the bottom of receipts” label. 
The graphic image for the selected identifier only will be printed if the data for the 
selected Text-Key were found on a Print-Job. 
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5-7 Bidirectional Communication 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) Click Ports tab.  
 
Because “bidirectional support” is disabled by default, it is necessary to tick Enable 
bidirectional support to get status from the printer. Sample codes contained in the CD 
can help you get more status information than the status information that OS supplies as 
standard way. This windows driver supports only one-on-one communication between the 
printer and host (typically a PC). 
 
Printer status available to check: 
- COVER OPEN/CLOSE 
- PAPER EMPTY 
- NEAR END PAPER 
- CASH DRAWER OPEN/CLOSE 
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6. Windows Driver Specifications 
 
6-1 Fonts 
 
This Windows driver supports various fonts in the following table. Printing using these fonts  
is faster than using Windows fonts provided by the operating system.  
 
 
6-1-1 Standard Fonts 
 

Printer font Font Size (dot) Font Size (point) 

FontA1x1 FontA1x1[Ext.] FontA1x1[255] 12 x 24 9.5 

FontA1x2 FontA1x2[Ext.] FontA1x2[255] 12 x 48 19 

FontA2x1 FontA2x1[Ext.] FontA2x1[255] 24 x 24 9.5 

FontA2x2 FontA2x2[Ext.] FontA2x2[255] 24 x 48 19 

FontA2x4 FontA2x4[Ext.] FontA2x4[255] 24 x 96 38.5 

FontA4x2 FontA4x2[Ext.] FontA4x2[255] 48 x 48 19 

FontA4x4 FontA4x4[Ext.] FontA4x4[255] 48 x 96 38.5 

FontA4x8 FontA4x8[Ext.] FontA4x8[255] 48 x 192 77 

FontA8x4 FontA8x4[Ext.] FontA8x4[255] 96 x 96 38.5 

FontA8x8 FontA8x8[Ext.] FontA8x8[255] 96 x 192 77 

FontB1x1 FontB1x1[Ext.] FontB1x1[255] 9 x 17 7 

FontB1x2 FontB1x2[Ext.] FontB1x2[255] 9 x 34 13.5 

FontB2x1 FontB2x1[Ext.] FontB2x1[255] 18 x 17 7 

FontB2x2 FontB2x2[Ext.] FontB2x2[255] 18 x 34 13.5 

FontB2x4 FontB2x4[Ext.] FontB2x4[255] 18 x 68 27 

FontB4x2 FontB4x2[Ext.] FontB4x2[255] 36 x 34 13.5 

FontB4x4 FontB4x4[Ext.] FontB4x4[255] 36 x 68 27 

FontB4x8 FontB4x8[Ext.] FontB4x8[255] 36 x 136 54.5 

FontB8x4 FontB8x4[Ext.] FontB8x4[255] 72 x 68 27 

FontB8x8 FontB8x8[Ext.] FontB8x8[255] 72 x 136 54.5 

FontC1x1 FontC1x1 [Ext.] FontC1x1 [255] 9 x 24 9.5 

FontC1x2 FontC1x2 [Ext.] FontC1x2 [255] 9 x 48 19 

FontC2x1 FontC2x1 [Ext.] FontC2x1 [255] 18 x 24 9.5 

FontC2x2 FontC2x2 [Ext.] FontC2x2 [255] 18 x 48 19 

FontC2x4 FontC2x4 [Ext.] FontC2x4 [255] 18 x 96 38.5 

FontC4x2 FontC4x2 [Ext.] FontC4x2 [255] 36 x 48 19 

FontC4x4 FontC4x4 [Ext.] FontC4x4 [255] 36 x 96 38.5 

FontC4x8 FontC4x8 [Ext.] FontC4x8 [255] 36 x 192 77 

FontC8x4 FontC8x4 [Ext.] FontC8x4 [255] 72 x 96 38.5 

FontC8x8 FontC8x8 [Ext.] FontC8x8 [255] 72 x 192 77 
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6-1-2 Meaning of names of Device fonts. 
 

1) FontA1x2 
- ANSI Character code support (Code page 16: 1252) 
- Font size (dot): 12 x 48 (Double height) 
- Point size: 19 

 
2) FontA1x2 [Ext] 

- IBM expansion Character code support (Code page 0: 437)  
- Font size (dot): 12 x 48 (Double height) 
- Point size: 19 

 
3) FontA1x2 [255] 

- BUYER ONLY code support (Code page 255)  
- Font size (dot): 12 x 48 (Double height) 
- Point size: 19 
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6-2 “FontControl” Font 
 
This Windows driver supports the special functions as shown in the following table. 
Select the “FontControl” character first and use the characters in the table to use the 
special functions. Take care as this function is not for printing general texts.  
 

Character Special Functions 
5 Print HT (0 x 09) 

6 Print LF (0 x 0A) 

7 Print CR (0 x 0D)  

a Open Drawer 2 (50ms driver pulse width) 

b Open Drawer 2 (100ms driver pulse width) 

c Open Drawer 2 (150ms driver pulse width) 

d Open Drawer 2 (200ms driver pulse width) 

e Open Drawer 2 (250ms driver pulse width) 

f Open Drawer 2 without paper feeding (50ms driver pulse width) 

g Cut without paper feeding 

i Prints the NV Image saved in the 00 address (double-size) 

j Prints the NV Image saved in the 01 address (double-size) 

k Prints the NV Image saved in the 02 address (double-size) 

l Prints the NV Image saved in the 03 address (double-size) 

m Prints the NV Image saved in the 04 address (double-size) 

p Do not add HRI characters to barcode 

q Add HRI characters above the bard code with Font A 

r Add HRI characters below the bard code with Font A 

s Add HRI characters above the bard code with Font B 

t Add HRI characters below the bard code with Font B 

u Turns white/black reverse printing mode on 

v Turns white/black reverse printing mode off 

w Align text to the left 

x Align text to the center 

y Align text to the right 

A Open Drawer 1 (50ms driver pulse width) 

B Open Drawer 1 (100ms driver pulse width) 

C Open Drawer 1 (150ms driver pulse width) 

D Open Drawer 1 (200ms driver pulse width) 

E Open Drawer 1 (250ms driver pulse width) 

F Open Drawer 1 without paper feeding (50ms driver pulse width) 

G Prints the NV bitmap image 1 

H Prints the NV bitmap image 2 

I Prints the NV bitmap image 3 

J Prints the NV bitmap image 4 

K Prints the NV bitmap image 5 

P Cut (partial cut) 

R Prints the NV Image saved in the 00 address 

S Prints the NV Image saved in the 01 address 

T Prints the NV Image saved in the 02 address 

U Prints the NV Image saved in the 03 address 

V Prints the NV Image saved in the 04 address 

[ Prints the NV bitmap image 1 (double-size) 

] Prints the NV bitmap image 2 (double-size) 

^ Prints the NV bitmap image 3 (double-size) 

_ Prints the NV bitmap image 4 (double-size) 

` Prints the NV bitmap image 5 (double-size) 
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1) Example : Select “FontControl” font  and send 6 for “LF” (Line Feed) operation  
(instead of printing character “6”).  

 
2) “FontControl” character function 

 

Printer font special 
function 

Function Point size (point/dot) 

FontControl 

Open Drawer 1 /2  
Cut receipt 

Cut receipt (without paper feeding) 
Align (left/center/right) 

Print HT, LF, CR 
Print barcode 

Print NV bitmap image 

(9.5 / 12x24) 
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7. Windows Driver Application 
 
7-1 Application with Visual Basic 
 
This section contains example codes to control the printer using Windows driver with 
Visual Basic. Sample codes contained in the CD. 
 
 
7-1-1 Windows driver selection 
 
The following code is an example of the selection of the BIXOLON SRP-350plusIII 
Windows Driver. 
 

 
For Each prnPrinter In Printers 
 
If prnPrinter.DeviceName = “BIXOLON SRP-350plusIII” Then 
 
Set Printer = prnPrinter 
 
Exit For 
 
End If 
 
Next 

 

 
 

7-1-2 Text Printing 
 
The following example code explains how to print texts using Windows Fonts and Device 
Fonts. 
 

 
‘Print in Windows font 
Printer.FontSize = 9 
Printer.FontName = “Arial” 
Printer.Print “Arial Test”  
 
 
‘Print in printer font 
Printer.FontSize = 9.5 
Printer.FontName = “FontA1x1” 
Printer.Print “FontA1x1 Test” 
 
Printer.EndDoc 
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7-1-3 Barcode Printing 
 
The following example code explains how to print the barcode (JAN8 (EAN)). 
 

 
'Print Bar Code. 
Printer.FontSize = 20  
 
Printer.FontName = "Barcode4" 
Printer.Print "1234567" 
 
Printer.EndDoc 

 

 
The following example code explains how to print the 2-D barcode (PDF417). 
 

 
'Print Two-dimensional Codes. 
Printer.FontSize = 9.5 
 
Printer.FontName = "2D-Code1" 
Printer.Print "Print Test PDF417" 
 
Printer.EndDoc 
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7-2 Application with WordPad 
 
7-2-1 WordPad environment setting 
 
After running WordPad and setting the following conditions, conduct a test. 
 

- Select Printer 
After selecting “Print” from the “File” tab, select the printer (BIXOLON SRP-350plusIII). 

 
- Select Paper Size, Orientation, and Margins 

After selecting “Page Settings” from the “File” tab, select the paper size, orientation, 
and margins. 

 
 
7-2-2 Text Printing 
 
Use the Windows Driver of the printer to run a test. 
 

 
 
1) Select the desired font from the Font menu (FontA1x1). 
 
2) Select the desired font size (9.5). 
 
3) Enter the text to be printed in WordPad. 
 
4) Click the Print button in the toolbar to print. 
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